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Introduction

About this ebook

This ebook is a comprehensive reference list of over 1,000 keyboard shortcuts for
Microsoft Olce v.X. The Olce v.X suite comprises Word, Excel, Entourage and
PowerPoint.

Using keyboard shortcuts instead of your mouse can greatly increase your
elciently and productivity on your Apple computer.

To learn more about other Mac OS X keyboard shortcuts and access later versions
of Olce keyboard shortcuts please visit www.osxkeyboardshortcuts.com

Also online is How to Use Mac OS X Keyboard Shortcuts for Leopard; a
comprehensive desktop reference guide available in both pdf and print formats.
Visit www.osxkeyboardshortcuts.com/products.html

How to Use Mac OS X Keyboard Shortcuts  includes:

¥ Over 1000 quick shortcuts for OS X 10.5 Leopard

¥ Shortcuts for OS X, Finder, Apple Mail, Address Book, Safari, iTunes
¥ Shortcuts for iLife '08 (iPhoto, iWeb, iMovie, iDVD and GarageBand)
¥ In-depth descriptions of all keys and symbols

¥ Mac OS X troubleshooting keys

¥ Accents and special characters

¥ Currency and mathematics symbols

¥ Punctuation and foreign characters

¥ Using the Character Palette to access 1,000s of characters & symbols
¥ Clear concise information tables

¥ Move instantly between applications

¥ Navigate easily to save time and money

¥ Spiral bound in high quality print or ebook pdf

Some Quick Theory

This book is written exclusively for Mac OS X Leopard. OMac OS XO means
Macintosh Operating System Version 10 (there were nine other versions before
this one) and "Leopard" is the latest generation in the OS X series.

Operating system is simply the name given to the underlying software that makes
your computer work.
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There are two basic ways to give an instruction on your Mac. One is through
pressing the keys on the keyboard and the other is by moving and clicking the
mouse. This book contains hundreds of ways to command your Mac in Olce
2008 by pressing just the keys.

Note:
1. Using a non-standard Apple keyboard or altering your default keyboard
shortcut settings may cause some keyboard shortcuts to not function correctly.

2. Keyboard shortcut descriptions refer to the U.S. keyboard layout. Keys on other
keyboard layouts might not correspond to the keys on a U.S. keyboard. Keyboard
shortcuts for laptop computers might also di"er.

3. The settings in some versions of the Macintosh operating system and some
utility applications might conf3ict with keyboard shortcuts and function key
operations in Olce.

For information about changing the key assignment of a keyboard shortcut, see
Mac Help for your version of the Macintosh operating system or see your utility
application.

Understanding Symbols

When you click the top menu bar on your screen, for example OFileO, you will see a
vertical menu drop down displaying various words and phrases. These words and
phrases are commands. To the right of some of these commands are groups of
symbols and characters. Two examples are O#00 and O$#SO.

This notation is Apple shorthand for keyboard shortcuts - each shortcut refers to
a specibc command.

ItOs important you learn what each symbol represents so that you know which
keys to press when applying a shortcut. This is presented in further detail on the
Keyboard Symbols table (page 5).
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Apple Keyboard Symbols

Symbol
3

© v P C

1

fn
caps Lock
drag

space
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Key

Command (also displayed as @ or @ on older
keyboards)

Shift

Option

Control

Delete (delete to the left)

Del (delete to the right - only on some
keyboards)

Escape or Esc
Eject

Return
Power

Left Arrow
Right Arrow
Up Arrow
Down Arrow
Home

End

Page Up
Page Down
Tab

Click the mouse button (usually the top left
button on a non-Apple mouse)

Enter

Function

Caps Lock

Drag the object with the mouse click held down

Space
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Chapter 1
Word v.X
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Aligning Paragraphs

~{+M
FE
3)
oL
¥R
+¥M
THET
F*T

Applying Character Formats
~space

{F3

=

¥B

#D

81
¥+

T #A
4 #D
4 ¥H
T #K
THEW
¥#U

Applying Paragraph Styles
¥l

Copyright © 2008 Dean Pirera Byron IT
www.osxkeyboardshortcuts.com

Indent a paragraph from the left

Centre a paragraph

Justify a paragraph

Left align a paragraph

Right align a paragraph

Remove a paragraph indent from the left
Reduce a hanging indent

Create a hanging indent

Remove manual character formatting

Change the case of letters

Apply subscript formatting (automatic spacing)
Apply bold formatting

Change the formatting of characters (Font
command, Format menu)

Apply italic formatting

Apply superscript formatting (automatic
spacing)

Format letters as all capitals
Double-underline text

Apply hidden text formatting
Format letters as small capitals
Underline words but not spaces

Apply an underline

Apply the Heading 1 style



http://www.osxkeyboardshortcuts.com
http://www.osxkeyboardshortcuts.com

Applying Paragraph Styles (continued)

882 Apply the Heading 2 style
83 Apply the Heading 3 style
N ¥K Start AutoFormat

8L Apply the List style

T #N Apply the Normal style

1+ 88S Apply a style

Changing or Resizing the Font

B[ Decrease the font size by 1 point
8] Increase the font size by 1 point
T ¥< Decrease the font size

T8> Increase the font size

4 38F Change the font

Creating, Viewing and Saving Documents

F$N Create a new document of the same type as the
default normal template

$0 Open a document

\§8S Split the document window; remove the
document window split

¥*S Save a document
1+ 3P Open the Project Gallery
W Close a document

Deleting Text and Graphics

> or Clear Delete one character to the right
] Delete one character to the left
Copyright © 2008 Dean Pirera Byron IT 8
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Deleting Text and Graphics (continued)

H
FK
F#F3

¥X or F2
4

Document Outline (in outline view)
AD
~r 4+
~rl
~BA
~rl
~{rL
AL e
Ao
~t
4N

Extending a Selection
F8

F8 (once to select a word twice to
select a sentence and so on)

F8¢+ or F8—
1{*F8
3.

Delete one word to the right
Delete one word to the left

Cut to the Spike, a special AutoText entry that
stores multiple items that you've deleted

Cut selected text to the Clipboard

Undo the last action

Collapse text under a heading

Expand text under a heading

Show all headings with the Heading 1 style
Expand or collapse all text or headings

Move selected paragraphs down

Show the first line of body text or all body text
Promote a paragraph

Demote a paragraph

Move selected paragraphs up

Demote to body text

Turn extend mode on

Increase the size of a selection

Select the nearest character

Reduce the size of a selection

Turn extend mode off
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Fields

F9

F11
\F9
X4F9

{4F11
{4F9
#F11
4 #F11
T #F9

Fields Insert Fields
~4D

~P

T

¥F9

N 8L

Update selected fields
Go to the next field
Switch between all field codes and their results

Run GOTOBUTTON or MACROBUTTON from the
field that displays the field results

Go to the previous field

Switch between a field code and its result
Lock a field

Unlock a field

Unlink a field

Insert a DATE field
Insert a PAGE field
Insert a TIME field
Insert an empty field

Insert a LISTNUM field

Finding, Replacing and Browsing through Text

3BF
#G

N#EN

\#Y

\38Z

Find text, formatting, and special items

Go to a page, bookmark, footnote, table,
comment, graphic, or other location

Browse through a document

Repeat find (after closing Find and Replace
window)

Go back to a page, bookmark, footnote, table,
comment, graphic, or other location
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Function Key

F1 Undo the last action

F2 Cut text or graphics

F3 Copy text or graphics

F4 Paste the Clipboard contents

F5 Choose the Go To command (Edit menu)

F6 Go to next pane or frame

F7 Choose the Spelling and Gramma r command

(Tools menu)

F8 Extend a selection

F9 Update selected fields

F11 Go to the next field

F12 Choose the Save As command (File menu)

# Function Key

¥F2 Choose the Print Preview command (File
menu)

8F3 Cut to the Spike

¥#F4 Close the window

$F5 Restore the document window size

#F6 Go to the next window

¥8F9 Insert an empty field

¥F11 Lock a field

Inserting Paragraphs and Tab Characters"in a Table

© New paragraphs in a cell
- Tab characters in a cell
Copyright © 2008 Dean Pirera Byron IT 11
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Inserting Special Characters

¥

N2

G

R
\_space

< (after typing the first few
characters of the AutoText entry
name and when the ScreenTip
appears)

O
0e
&F9
3

Moving and Copying Text and Graphics
\F3

#CorF3

T #F3

¥V or F4

¥X or F2 (then move the insertion
point and press 38V or F4)

Moving around in a Dialog Box

~t-oorl

~{r—or %
~oor N

o

An ellipsis

The trademark symbol

The copyright symbol

The registered trademark symbol
A non-breaking hyphen

An AutoText entry

A page break
A line break
A field

A column break

Create AutoText

Copy text or graphics

Paste the Spike contents
Paste the Clipboard contents

Move text or graphics

Move between options in the selected list or
between some options in a group of options

Switch to the previous tab in a dialog box
Switch to the next tab in a dialog box

Perform the action assigned to the default
button in the dialog box

Copyright © 2008 Dean Pirera Byron IT 12
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Word v.X

Moving around in a Dialog Box (continued)

-1

-l

3.

Moving around in a Table
N

N

e

~%

1

e

Moving around in the Help Topic Pane

Move to the previous option or option group
Move to the next option or option group

Cancel the command and close the dialog box

Last cell in a row
First cell in a row
Last cell in a column
First cell in a column
Next row

Previous cell in a row
Next cell in a row

Previous row

The following keys are for moving around in the topic pane of the Help window.

i

#8C
H
¥

BW

Scroll toward the end of a Help topic one line at
atime

Scroll toward the end of a Help topic one
screen at a time

Scroll toward the beginning of a Help topic one
screen at a time

Scroll toward the beginning of a Help topic one
line at a time

Copy the selected items to the Clipboard
Go to the previous Help topic
Go to the next Help topic

Close the Help window

Copyright © 2008 Dean Pirera Byron IT 13
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Word v.X

Moving around or Selecting Text in a Text Box

N Move to the end of the line

N Move to the beginning of the line

~ or — Move one character to the left or right

TN Select from the insertion point to the end of
the line

N Select from the insertion point to the beginning
of the line

e« Select or cancel the selection of one character
to the left

- Select or cancel the selection of one character
to the right

$e—orE— Move one word to the left or right

03— Select or cancel the selection of one word to
the left

08— Select or cancel the selection of one word to
the right

Moving in or among Document and Program Windows

¥F6 Switch to the next Word document window
1+ 88F6 Switch to the previous Word document window
W Close the active document window

Moving the Insertion Point

I Down one line

N To the end of a line

N To the beginning of a line
- One character to the left

3 Down one screen (scrolling)
E Up one screen (scrolling)

Copyright © 2008 Dean Pirera Byron IT 14
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Moving the Insertion Point (continued)

-

4F5

-l

¥l

E:3aN
H—
¥
¥

#®1

# Function Key
\F3
\F6
XF7

\F8
\F9
\F1l1

#3$ Function Key
. {*F6

One character to the right

To a previous revision or To the location of the
insertion point when the document was last
closed

One cell to the left (in a table)
One cell to the right (in a table)
Up one line

One paragraph down

To the end of a document

To the beginning of a document
One word to the left

To the top of the next page

To the top of the previous page
One word to the right

One paragraph up

Create an AutoText entry
Go to the next window

Find the next misspelling or grammatical error.
The Check spelling as you type check box
must be selected (Word menu, Preferences
command, Spelling and Grammar ).

Run a macro
Switch between all field codes and their results

Display Microsoft Visual Basic code

Go to the previous window
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#3$ Function Key (continued)

X{4F7
X{4F9

Performing a Data Merge

Opens the Dictionary

Run GotoButton or MacroButton from the field
that displays the field results

To use these keystrokes, you must first set up a main document for a data merge.

While using the Data Merge Manager:

~OE
~QF
~gK
~gN

Printing and Previewing Documents

~T-oorl

tort
B\

BN

38l
*P

Resize Table Columns Directly in a Table

Edit a data-merge data document

Insert a merge field
Checks for errors

Merge a document

Move around the preview page when zoomed
in

Move by one preview page when zoomed out

Move to the last preview page when zoomed
out

Move to the first preview page when zoomed
out

Switch in or out of Print Preview

Print a document

Press the shortcut keys, and then drag a column boundary

No key

i

Move a single column line while keeping the
width of the table the same

Change table width while keeping the sizes of
columns to the right the same

Copyright © 2008 Dean Pirera Byron IT 16
www.osxkeyboardshortcuts.com



http://www.osxkeyboardshortcuts.com
http://www.osxkeyboardshortcuts.com

Word v.X

Resize Table Columns Directly in a Table (continued)

8 Proportionally resize all columns to the right
while keeping the width of the table the same

38 Equally resize all columns to the right whilst
keeping the width of the table the same

Tip. To finely adjust a column width, press C while pressing the keyboard shortcut.
This allows the column line to move to any position, instead of making it snap to the
document grid.

Reviewing Documents

N Go to the end of a comment

N Go to the beginning of a comment

N\ Go to the end of the list of comments

E:3aN Go to the beginning of the list of comments
\¥A Insert a comment

O $E Turn track changes on or off

Selecting Multiple Items

Select the first item you want hold Select multiple items that are not next to each
down 3 and then select any other
additional items you want.

Selecting Text and Graphics

Select text by holding down 1+ and pressing the key that moves the insertion point.

- One character to the right
e One character to the left
¥ To the end of a word
T3 To the beginning of a word
TN\ To the end of a line
Copyright © 2008 Dean Pirera Byron IT 17
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Selecting Text and Graphics (continued)

N To the beginning of a line

F8+ F8T F8— or F8! (press &. to To a specific location in a document
cancel selection mode)

N To the end of a window

a4l One line down

% One screen down

% One screen up

o1 One line up

FHA To include the entire document
78l To the end of a paragraph
T8N To the beginning of a document
48T To the beginning of a paragraph
TEN To the end of a document

{0+ 38F8«+— {+38F8T {+88F8— or +¥F8!  To a vertical block of text
(press 3. to cancel selection mode)

Tip. If you know the key combination to move the insertion point, you can select text
by holding down {* as you move the insertion point. For example, ¥ — moves the
insertion point to the next word, and 4+ — selects the text from the insertion point to
the beginning of the next word.

Selecting Text and Graphics in a Table

¥ in the column's top or bottom cell. = Select a column
Hold down 1+ and press T or —
repeatedly

Hold down {+ and press « T — or | Extend a selection to adjacent cells
repeatedly

Select the first item you want, hold Select multiple cells, columns or rows that are
down 3 and then select any not next to each other
additional items you want.

TF8 Reduce the selection size
- Select the preceding cell's contents
Copyright © 2008 Dean Pirera Byron IT 18
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Selecting Text and Graphics in a Table (continued)

-l Select the next cell's contents

O HF8— +HF8T {+38F8— or 4 ¥F8! Extend a selection (or block)
(press 3. to cancel selection mode)

Setting Line Spacing

80 Add or remove one line space preceding a
paragraph

#1 Single-space lines

32 Double-space lines

85 Set 1.5 line spacing

$ Function Key

{F2 Copy text

TF3 Change the case of letters

1F4 Repeat a Find or Go To action

1F5 Move to a previous revision

1F6 Go to the previous pane or frame

4F7 Choose the Thesaurus command (Tools menu)
4F8 Shrink a selection

4F9 Switch between a field code and its result
4F10 Display a contextual menu

{F11 Go to the previous field

{+3 Function Key

1+ 88F3 Insert the contents of the Spike
1+ 38F4 Repeat a Find or Go To action
1+ 88F5 Edit a bookmark
Copyright © 2008 Dean Pirera Byron IT 19
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{+3 Function Key (continued)

1+ 3F6
T HF7

4 #F8

4+ #F9
T4¥1l

Switching to Another View
&N
30
P

Undoing and Redoing Actions
.
Y
¥z

Using the O%ce Assistant

Go to the previous window

Update linked information in a Word source
document

Extend a selection or block (then press an
arrow key)

Unlink a field
Unlock a field

Switch to normal view
Switch to outline view

Switch to page layout view

Cancel an action
Redo or repeat an action

Undo an action

To perform most of the following actions, the Office Assistant must be turned on and

visible.

O

Help, if the balloon isn't showing

Using Toolbars

Close an Assistant message or a tip

Display the Assistant balloon

To turn on keyboard navigation, press \F10. After you turn on keyboard navigation,
you can use the keyboard shortcuts listed below.

Copyright © 2008 Dean Pirera Byron IT 20
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Word v.X

Using Toolbars (continued)

—t1T->o0rl

Ao or Mo

1l (when a menu on a toolbar is
selected)

+ (after entering a value in a text
box)

< (when a button is selected)

< (when a drop-down list box is
selected)

— or « (when a toolbar is active)

Viewing and Copying Text Formats
¥*8

+3C

ih:4Y

Working with Footnotes and Endnotes
\#E
\3#F

Move through options in a menu or drop-down
list

Select the next or previous toolbar

Open the menu

Accept that value

Perform the action assigned to a button

Select the option you want

Select the next or previous button or menu on
the toolbar

Display non-printing characters
Copy formats

Paste formats

Insert an endnote

Insert a footnote

Working with Tables - Resize Table Columns by using the Ruler

Press the shortcut keys, and then drag a marker on the ruler

No key

i

Change table width while keeping the sizes of
columns to the right the same

Move a single column line while keeping the
width of the table the same

Copyright © 2008 Dean Pirera Byron IT 21
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Word v.X

Working with Tables - Resize Table Columns by using the Ruler (continued)

8 Proportionally resize all columns to the right
while keeping the width of the table the same

88 Equally resize all columns to the right while
keeping the width of the table the same

Copyright © 2008 Dean Pirera Byron IT 22
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Chapter 2
Excel v.X
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Excel v.X

Charts

F11 Create a chart

~T-o0rl Cycle through chart object selection
~6 Alternate between hiding chart objects,

displaying chart objects, and displaying
placeholders for chart objects

Customize Keyboard Shortcuts

If you'd rather use the keyboard than the mouse or if you want to change some of the
default keyboard shortcuts, you'll appreciate a new feature in Microsoft Excel for Mac.
In Excel, you can add and change keyboard shortcuts for menu commands and other
features.

Assign a keyboard shortcut:

1. If you are using Excel X, on the Tools menu, click Customize , and then at the
bottom of the Customize dialog box, click Keyboard . If you are using Excel 2004, on
the Tools menu, point to Customize , and then click Customize Keyboard

2. In the Customize Keyboard  dialog box, select a category from the Categories list
to see the commands and other items associated with that category.

3. Click the command you want in the list to the right.

Note: If there is currently a keyboard shortcut associated with the command, it is
displayed in the Current keys box.

4. Click inside the Press new shortcut  key box.

5. Press the key combination you want to use for the command.

6. Click Add

7. After you have finished assigning all the shortcuts you want, click OK.

Note: If you change your mind now or later, you can reset the shortcuts by clicking
Reset All .

Data Forms

1] Move to the same field in the next record
- Move one character left within a field

- Move one character right within a field

Copyright © 2008 Dean Pirera Byron IT 24
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Excel v.X

Data Forms (continued)

T Move to the same field in the previous record
~% Move to a new record
AE Move to the first record

Move to the end of a field

Move to the beginning of a field

3 Move to the same field 10 records forward

$ Move to the same field 10 records back

e Move to the first field in the next record

4N Extend a selection to the end of a field

N Extend a selection to the beginning of a field

iy Select the character to the left

e Move to the first field in the previous record

- Select the character to the right

- Move to the previous field you can edit in the
record

-l Move to the next field you can edit in the
record

Dialog Boxes

~r—or % Switch to the previous tab in a dialog box
~oor N E Switch to the next tab in a dialog box

O Cancel the command and close the dialog box
L Perform the action assigned to the default

command button in the dialog box (the button
with the bold outline —- often the OK button)

it Move to the previous text box
-l Move to the next text box
Copyright © 2008 Dean Pirera Byron IT 25
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Excel v.X

Editing Data

~A

~A

~U

O
)
¥ or "0

*V

Entering Worksheet Data
~Dor "r<

i

~“F3 or ~L
~Ror ~"{*>

~O

~{+F3
B>

Display the Formula Palette after you type a
valid function name in a formula

Insert the argument names and parentheses for
a function, after you type a valid function name
in a formula

Edit the active cell

Clear or edit the active cell. When you are
editing a cell, delete the character to the left of
the insertion point.

Cancel an entry in the cell or formula bar
Complete a cell entry
Enter a formula as an array formula

Paste text into the active cell

Fill down

Delete text from the insertion point to the end
of the line

Define a name
Start a new line in the same cell
Fill to the right

Fill the selected cell range with the text that
you type (works on nonadjacent selections)

Create names from row and column labels

Delete the character to the right of the
insertion point, or delete the selection

Delete the character to the left of the insertion
point, or delete and edit the active cell

Cancel a cell entry

Move to the beginning of the line

Copyright © 2008 Dean Pirera Byron IT 26
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Excel v.X

Entering Worksheet Data (continued)

S

4F2
@Hre

-

BY

Formatting Data

~O#

~ %

~0(
~{)

AL~
~0

Complete a cell entry and move down in the
selection, or move in the direction that is
selected on the Edit tab (Edit menu, Preferences
command)

Edit a cell comment

Complete a cell entry and move up in the
selection, or move opposite to the direction
that is selected on the Edit tab (Edit menu,
Preferences command)

Complete a cell entry and move to the left in
the selection, or move opposite to the direction
that is selected on the Edit tab (Edit menu,
Preferences command)

Complete a cell entry and move to the right in
the selection, or move in the direction that is
selected on the Edit tab ! Edit menu, Preferences
command"

Repeat the last action

Apply the Date format with the day, month,
and year

Apply the Currency format with two decimal
places (negative numbers appear in
parentheses)

Apply the Percentage format with no decimal
places

Unhide rows
Unhide columns

Apply the Time format with the hour and
minute, and indicate A.M. or P.M.

Apply the Exponential number format with two
decimal places

Apply the General number format

Hide columns

Copyright © 2008 Dean Pirera Byron IT 27
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Formatting Data (continued)

~9 Hide rows

~ ! Apply the Number format with two decimal
places, thousands separator, and minus sign
(-) for negative values

81 Display the Format Cells dialog box

B Apply or remove bold formatting

$E Align centre

8l Apply or remove italic formatting

8L Align left

#FM Indent

- Remove outline borders

&0 Apply the outline border

A Apply or remove bottom border

AL Apply or remove left border

- Apply or remove right border

8T Apply or remove top border

#R Align right

3 Apply or remove strikethrough formatting

0 ¥< Decrease font size

8> Increase font size

43D Add or remove outline on text

8L Display the Style dialog box

T ¥EM Remove indent

38U Apply or remove an underline

T HEW Add or remove shadow on text
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Inserting, Deleting and Copying Selections

~—or ~K
~lor M+

&

#Cor ~C
#Vor "V
#X or ~X
Y
¥z

Moving within a Selection

A

/\'\__‘_

/\'\___’

G

-1

Delete the selection
Insert blank cells

Clear or edit the active cell. When you are
editing a cell, delete the character to the left of
the insertion point.

Copy the selection
Paste the selection
Cut the selection
Repeat the last action

Undo the last action

Move clockwise to the next corner of the
selection (does not move to nonadjacent
selections)

Move to the left among nonadjacent selections

Move to the right among nonadjacent
selections

Move from top to bottom within the selection
(down), and then move to the top of the next
column. Or move in the direction that is
selected on the Edit tab (Edit menu, Preferences
command)

Move from bottom to top within the selection
(up), and then move to the bottom of the next
column. Or move opposite to the direction that
is selected on the Edit tab (Edit menu,
Preferences command)

Move from right to left within the selection,
and then move to the previous row. Or move
up one cell if only one column is selected

Move from left to right within the selection,
and then move to the next row. Or move down
one cell if only one column is selected
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Navigating

~t-orl

N AT Ao or
~G

AN

~%

~%

P

A

F6

AW
X#

HX or "X
BF
@

3#H
4#G

Move to the next cell

Move to the edge of the current data region
Display the Go To dialog box

Move to the beginning of the worksheet
Move to the next sheet in the workbook
Move to the previous sheet in the workbook
Move to the previous workbook or window
Move to the next workbook or window

Move to the next pane in a workbook that has
been split

Move to the beginning of the row
Move one screen to the right
Move one screen to the left

Move down one screen

Move up one screen

Move to the previous pane in a workbook that
has been split

Move between unlocked cells on a protected
worksheet

Scroll to display the active cell
Display the Find dialog box

Repeat the last Find action (same as Find
Next ), or, if no Find has been performed, move
to the next blank cell

Display the Replace dialog box (Edit menu)

Repeat the last Find action, or, if no Find has
been performed, move to the previous blank
cell
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Opening, Closing and Saving

N or ~N Create a new workbook
#$0 or ~O Open an existing workbook
$Q Quit Excel

S or ~S Save the current workbook

Outlining Data

~0 Hide selected columns

~8 Display or hide outline symbols

~9 Hide selected rows

~4r) Unhide selected columns

Pivot-Tables

#C Move the selected field into the Column area in
the Layout dialog box in step 3 of the Pivot-
Table Wizard

8D Move the selected field into the Data area in
the Layout dialog box in step 3 of the Pivot-
Table Wizard

BL Display the Pivot-Table Field dialog box from
the Layout dialog box in step 3 of the Pivot-
Table Wizard

$P Move the selected field into the Page area in
the Layout dialog box in step 3 of the Pivot-
Table Wizard

#R Move the selected field into the Row area in
the Layout dialog box in step 3 of the Pivot-
Table Wizard

Previewing and Printing

~T-oorl Move around the page when zoomed in
~lor~— Move to the last page when zoomed out
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Previewing and Printing (continued)
A1 or Ne

tort

P

Selecting Cells, Rows and Columns

~6

~7

/\ﬁ:‘:

Afre AOT Ao or LA D

N

N

~space

F8

O Ot 40> or {1
o4N

pied

F8

3

Move to the first page when zoomed out
Move by one page when zoomed out

Display the Print dialog box

For chart objects: Alternate between hiding
objects, displaying objects, and displaying
placeholders for objects. For drawing objects:
Alternate between hiding objects and
displaying objects.

Show or hide the Standard toolbar

Select the current region around the active cell
(the current region is an area enclosed by blank
rows and blank columns)

Extend the selection to the last nonblank cell in
the same column or row as the active cell

Extend the selection to the last cell used on the
worksheet (lower-right corner)

Extend the selection to the beginning of the
worksheet

Select the entire column

Turn on extending a selection by using the
arrow keys

Extend the selection by one cell

Extend the selection to the beginning of the
row

Select only the active cell when multiple cells
are selected

Add another range of cells to the selection; or
use the arrow keys to move to the start of the
range you want to add, and then press F8 and
the arrow keys to select the next range

Extend the selection down one screen
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Selecting Cells, Rows and Columns (continued)

% Extend the selection up one screen
{rspace Select the entire row
#A or ~{rspace Select the entire worksheet, or, if an object is

selected, all the objects on a worksheet

Selecting Cells with Special Criteria

~/ Select the current array, which is the array that
the active cell belongs to

~ Select only cells that are directly referred to by
formulas in the selection

~\ In a selected row, or a selection within a row,
select cells that don't match the value in the
active cell.

~] Select only cells with formulas that refer

directly to the active cell

N Select the current region around the active cell
(the current region is an area enclosed by blank
rows and blank columns)

~ Select all cells that are directly or indirectly
referred to by formulas in the selection

| In a selected column, or a selection within a
column, select cells that don't match the value
in the active cell.

~{} Select all cells with formulas that refer directly
or indirectly to the active cell

4¥O0 Select all cells with comments

887 Select only visible cells in the current selection

Using AutoFilter
N Select the last item in the AutoFilter list

N Select the first item (Sort Ascending) in the
AutoFilter list
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Using AutoFilter (continued)

© Filter the list by using the selected item in the
AutoFilter list

Select the cell that contains the Display the AutoFilter list for the current

column label and then press | column

T Select the previous item in the AutoFilter list

Using Function Keys

~F12 Open command
~F3 Define a name
~F4 Close the window
~F5 Restore the window size
~F6 Move to the next workbook window
~F10 Maximize or restore the workbook window
~F11 Insert a Microsoft Excel 4.0 macro sheet
~{3F12 Print command
~{+F3 Create names by using row and column labels
~{+F6 Move to the previous workbook window
F1 Undo command
F2 Cut text from the active cell
F3 Copy text from the active cell
F4 Paste text into the active cell
F5 Go To command
F6 Move to the next pane
F7 Spelling command
F8 Extend a selection
F11 Create a chart
F12 Save As command
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Using Function Keys (continued)

\F8
\F10
\F11
OF1
DF2
OF3
0F4
OF5
2F6
QF8
2F9
2F10
OF11
DF12

Using Toolbars

~{+— (when a toolbar is active)
~ =1 (when a toolbar is active)
\F10

o

-1 (when a toolbar is active)

-1 (when a toolbar is active)

Working within Cells and the Formula Bar

Display the Macro dialog box
Make toolbar active

Display Visual Basic Editor
What's This ? command

Edit a cell comment

Paste a function into a formula
Repeat the last Find (Find Next) action
Display the Find dialog box
Move to the previous pane
Add to the selection

Calculate the active worksheet
Display a contextual menu
Insert a new worksheet

Save command

Select the previous toolbar
Select the next toolbar
Make a toolbar active

Perform the action assigned to the selected
button

Select the previous button or menu on the
toolbar

Select the next button or menu on the toolbar

Start a formula

Enter the date
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Working within Cells and the Formula Bar (continued)

~T Alternate between displaying cell values and
displaying cell formulas

~A Display the Formula Palette after you type a
valid function name in a formula

~B Clear the selected cell's contents

~F3 Define a name

~ A Insert the argument names and parentheses for
a function, after you type a valid function name
in a formula

e or 0¥ Enter a formula as an array formula

~U Edit the active cell and position the insertion
point at the end of the line

O Cancel an entry in the cell or formula bar

Nl Display the AutoComplete list

e Complete a cell entry and move down in the

selection, or move in the direction that is
selected on the Edit tab (Edit menu,
Preferences command)

€ (in a cell with a hyperlink) Activate a hyperlink

4F3 Paste a function into a formula

4F9 Calculate the active worksheet

' or ™' Copy a formula from the cell above the active

cell into the cell or the formula bar

8; or 038: or ~1: Enter the time

¥=orF9 Calculate all sheets in all open workbooks
F$K Insert a hyperlink

48" or ~ 4" Copy the value from the cell above the active

cell into the cell or the formula bar

GET Insert the AutoSum formula

Copyright © 2008 Dean Pirera Byron IT 36
www.osxkeyboardshortcuts.com



http://www.osxkeyboardshortcuts.com
http://www.osxkeyboardshortcuts.com

Working with Windows

~F10
~F5
F6

{F6

F#F5
¥F6
{+38F6
43—
38—

HW

Maximize or restore the workbook window
Restore the window size

Move to the next pane in a workbook that has
been split

Move to the previous pane in a workbook that
has been split

Restore the active workbook window size
Switch to the next workbook window
Switch to the previous workbook window
Switch to the previous program

Switch to the next program

Close the active workbook window
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Address Book
ggl
[

38\
3]

FHA

#D
#K
3#EN
#0
T A

Assigning Items to Categories
3,

S

Calendar

38[

3]

33

FK

3#EN

Flag the selected contact

Close the current open contact and open the
previous contact in the Address Book list

Show or hide the Preview pane

Close the current open contact and open the
next contact in the Address Book list

Select all contacts if the Address Book is the
active pane

Duplicate the contact
Delete the contact

Create a new contact
Open the selected contact

Deselect all contacts

Assign the selected item to categories

Designate the selected category as the primary
category

In Day view move to the previous day. In Week
and Work Week views, move to the previous
week. In Month view, move to the previous
month.

In Day view, move to the next day. In Week and
Work Week views, move to the next week. In
Month view, move to the next month.

Cycle through Day, Work Week, Week, and
Month views.

Delete the calendar event

Create a new calendar event
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Calendar (continued)

#0
#T

Common Entourage Functions
Help

¥$H

$M

3P

\N#Q
3P
#Q
S
4P
*Y
¥Z

Custom Views
#D

2|

#EN

#0

Help Topic Pane
1

Open the selected calendar event

Switch the view to include today

Open Entourage Help
Hide Entourage
Minimize the active window

Print one copy of an item without selecting
printing options

Switch to a different identity
Print an item

Quit Entourage

Save an item

Open the Project Gallery
Redo the last action

Undo the last action

Duplicate the custom view
Delete the custom view
Create a new custom view

Open the selected custom view

Scroll toward the end of a Help topic one line at
atime
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Help Topic Pane (continued)

£ Scroll toward the end of a Help topic one
screen at a time

$ Scroll toward the beginning of a Help topic one
screen at a time

T Scroll toward the beginning of a Help topic one
line at a time

#C Copy the selection to the Clipboard

3 Go to the previous Help topic

$— Go to the next Help topic

$W Close the Help window

Messages - Creating, Addressing and Sending Messages
$E Add an attachment to the open message

F#K Send all messages in the Outbox and receive all
incoming messages

N Create a new message
L Check spelling in the open message
N In the Message list for a newsgroup create a

new mail message
¥ Send the open message

3#S Save the open message and store it in the
Drafts folder

+38C Check recipient names in the open message
38K Send all the messages in the Outbox
¥ Move the open message to the Outbox so it will

be sent the next time you connect to the server

Messages - Message List

38\ Show or hide the Preview pane
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Messages - Message List (continued)

FBA

#D
FX
*L

#EN
#0
&0

N#ET
T #A
T #N
4 #0

THET
#T

Messages - Reading Messages
[

~]

&1 or ®

Hold down the space

\_space

{rspace

space

Select all messages if the Message list is the
active pane

Duplicate the message
Delete the message

Refresh the Message list (IMAP, Hotmail, and
online POP accounts only)

Create a new message
Open the selected message

Turn on or off displaying flagged messages
only

Mark all messages in a folder as read
Deselect all messages
Create a new folder

Display only unread messages in the Message
list. Press again to see all messages.

Mark selected messages as unread

Mark selected messages as read

Display the previous unread message
Display the next unread message
Delete the selected message

Scroll down through a message slowly and
continuously

Scroll down to the next screen of text or, if you
are at the end of a message, delete the current
message and display the next unread message.

Scroll up to the previous screen of text

Scroll down to the next screen of text or, if you
are at the end of a message, display the next
unread message.
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Messages - Reading Messages (continued)
5"
38[
3]

=

#0

[

3]

N[

"\ ¥]

N#EX or LHX

T ¥
4 ¥-

4¥=

4 ¥H
4 ¥M

Messages - Reading Threaded Messages

~0

~0]

Flag the selected message
Display the previous message
Display the next message

Add the sender of the selected message to the
Address Book

Open the selected message in a separate
window

Delete the current message and display the
previous message

Delete the current message and display the
next message

Delete the current message and display the
previous unread message

Delete the current message and display the
next unread message

Delete the current message and, if the message
window is open, close it.

Flag a message for follow-up

Decrease the display size of text in an open
message or in the Preview pane

Increase the display size of text in an open
message or in the Preview pane

Show or hide Internet headers

Move the selected message to a folder

Read the last unread message of a previous
thread that contains an unread message

Read the first unread message of the next
thread that contains an unread message
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Messages - Reading Threaded Messages (continued)

At | Delete the current message and open the last
unread message in the next thread that
contains an unread message

ANaE Y Delete the current message and open the first
unread message in the next thread that
contains an unread message

AW 2! Delete all the messages in the thread

[ Delete the current message and read the last
message in the previous thread

(&) Delete the current message and read the first
message in the next thread

4 38[ Read the last message in the previous thread

7+ 8] Read the first message in the next thread

Messages - Responding to Messages

&) Forward the message

\HJ Redirect the message

¥R Reply only to the sender of a mailing list
message

#R Reply to the sender of the message or, if the
message is from a mailing list, reply to the
mailing list.

43R Reply to all

Notes

B[ Close the current open note and open the

previous note in the Notes list

8] Close the current open note and open the next
note in the Notes list

FBA Select all notes, if the Notes list is the active
pane.
8D Duplicate the note
Copyright © 2008 Dean Pirera Byron IT 44

www.osxkeyboardshortcuts.com



http://www.osxkeyboardshortcuts.com
http://www.osxkeyboardshortcuts.com

Entourage v.X

Notes (continued)

FK
¥#EN
#0

T A

O%ce Assistant
O

Help if the balloon isn't showing

Searching
.

¥$F

#G

\38F

¥#G

Tasks

38[

3]

3BA

#D
FX
#EN
¥0

Delete the note
Create a new note
Open the selected note

Deselect all notes

Close an Assistant message or a tip

Display the Assistant balloon

Cancel a search in progress
Find text in items

Find the next instance of the text you searched
for in an item

Perform an Advanced Find

Find the next instance of the selected text

Close the current open task and open the
previous task in the Tasks list

Close the current open task and open the next
note in the Tasks list

Select all tasks, if the Tasks list is the active
pane

Duplicate the task
Delete the task
Create a new task

Open the selected task
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Tasks (continued)

T A

Text - Cutting, Copying and Pasting
#$C
\#V

TV

H*V
F*X

Text - Formatting

B

381

U

Text - Macintosh-Style Text Editing

Deselect all tasks

Copy a selection to the Clipboard
Paste as plain text

Paste a selection from the Clipboard as a
quotation

Paste a selection from the Clipboard

Cut the selected text and copy it to the
Clipboard

Make the selected text bold in a note or in an
HTML message or signature

Make the selected text italic in a note or in an
HTML message or signature

Underline the selected text in a note or in an
HTML message or signature

For the following editing tasks, you can use standard Macintosh-style keyboard
shortcuts by turning off Microsoft Office keyboard shortcuts.

To turn Microsoft Office keyboard shortcuts on or off, click General Preferences on the
Entourage menu. Click the General tab, and then select or clear the Use Microsoft

O%ce keyboard shortcuts for editing text

(B

&l

check box.

Delete the character to the right of the
insertion point or delete the selected text

Delete the character to the left of the insertion
point or delete the selected text

Move the insertion point down one line

Scroll to the end of the message
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Text - Macintosh-Style Text Editing (continued)

N

-

N\l

AN

\—

FBA
*l

H

E

Text - Microsoft O%ce-Style Text Editing

Scroll to the beginning of the message
Move the insertion point left one character

Move the insertion point to the bottom of the
current or next screen or to the end of the
current selection

Move the insertion point to the beginning of
the current or previous word, or to the
beginning of the current selection

Move the insertion point to the end of the
current or next word or to the end of the
current selection

Move the insertion point to the top of the
current or previous screen or to the beginning
of the current selection

Scroll down one screen
Scroll up one screen
Move the insertion point right one character

Insert spaces up to the next tab stop or every
fifth character position

Move the insertion point up one line
Select all text

Move the insertion point to the end of a
message or to the end of the selected text

Move the insertion point to the beginning of
the line or to the beginning of the selected text

Move the insertion point to the end of the line
or to the end of the selected text

Move the insertion point to the beginning of a
message or to the beginning of the selected
text

For the following editing tasks, you can use Microsoft Office-style keyboard shortcuts.
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Text - Microsoft O%ce-Style Text Editing (continued)

To turn Microsoft Office keyboard shortcuts on or off, click General Preferences on the
Entourage menu. Click the General tab, and then select or clear the Use Microsoft
0O%ce keyboard shortcuts for editing text check box.

~lor N Move the insertion point to the end of the line
or to the end of the selected text

~or N Move the insertion point to the beginning of
the line or to the beginning of the selected text

x> Delete the character to the right of the
insertion point, or delete the selected text

& Delete the character to the left of the insertion
point, or delete the selected text

1 Move the insertion point down one line
— Move the insertion point left one character
N\l Move the insertion point to the bottom of the

current or next screen or to the end of the
current selection

A Move the insertion point to the beginning of
the current or previous word, or to the
beginning of the current selection

- Move the insertion point to the end of the
current or next word or to the end of the
current selection

T Move the insertion point to the top of the
current or previous screen or to the beginning
of the current selection

3 Move the insertion point down one screen

$ Move the insertion point up one screen

- Move the insertion point right one character
- Insert spaces up to the next tab stop or every

fifth character position
T Move the insertion point up one line

87T Move the insertion point to the beginning of
the previous paragraph

XA Select all text
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Text - Microsoft O%ce-Style Text Editing (continued)

®l

FE\

E:3aN

H

¥

Windows and Dialog Boxes

AN

N
X4F7
-

2

3*3

384

35

Move the insertion point to the beginning of
the next paragraph

Move the insertion point to the end of the
message

Move the insertion point to the beginning of
the message

Move the insertion point to the beginning of
the previous word or to the beginning of the
selected text

Move the insertion point to the end of the next
word or to the end of the selected text

Move back through tabs in a dialog box
Move forward through tabs in a dialog box
Open the definition dictionary

Move back through boxes in a dialog box
Move forward through boxes in a dialog box
Open the General Preferences dialog box
Cycle forward through open windows

Go to the Message list. To open the Message
list in @ new window press \ 81

Go to the Address Book. To open the Address
Book in a new window press 882

Go to the Calendar. Press again to cycle
through Day, Work Week, Week, and Month
views. To open the Calendar in a new window,
press \ 33

Go to the Notes list. To open the Notes list in a
new window, press \ 34

Go to the Tasks list. To open the Tasks list in a
new window, press 35
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Windows and Dialog Boxes (continued)

¥*6

¥7

#8

9

#0

\¥1
32
\¥3

\ 34
35
\ 36
. {+&N
\FHEW
0 38;

HW

Go to the Custom Views list. To open the
Custom Views list in a new window, press 6

Open the Progress window or make it the active
window

Open the Link Maker or make it the active
window

Open the Error Log or make it the active
window

Open the folder that is selected in the Folders
list in a new window

Open the Message list in a new window

Open the Address Book in a new window

Open the Calendar in a new window

Open the Notes list in a new window

Open the Tasks list in a new window

Open the Custom Views list in a new window
Open a new Entourage main window

Closes the active window and all open items
Open the Mail & News Preferences  dialog box
Cycle back through open windows

Close the active window
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Browsing Web Presentations

The following keys are for viewing your Web presentation in Microsoft Internet Explorer

4.0 or later.

&

~

-1

Changing PowerPoint Views
~rC

T

MV

~rX

~rZ

{}:¥ view button

E @

Deleting and Copying Text and Objects
&

F$gCorF3

#D

$X

¥V orF4

X or F2

¥ZorFl

Go to the previous slide

Perform the "mouse click" behavior of the
selected hyperlink

Move back through the hyperlinks in a Web
presentation, the Address bar, and the Links
bar.

Move forward through the hyperlinks in a Web
presentation, the Address bar, and the Links
bar.

Expand the slide pane

Switch to notes view

Switch to slide sorter view

Expand to outline pane

Switch to normal view

Switch from normal view to master view

Show or hide guides

Delete one character to the left or right
Copy selected object

Duplicate selected object

Delete one word to the left or right
Paste cut or copied object

Cut selected object

Undo the last action
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Dialog Boxes

“t-oorl
O

S

-1

Drawing Objects"

Select the object you want, and then
press +3C

Select the object you want, and then
press -3V

Select the object you want, and then
use <~ T —or|

=1 or (-1

Formatting Characters and Paragraphs

~space

TF3

3B
3*E
38l
)
3oL
*R

Move between options in a selected list
Cancel a command and close a dialog box

Perform the action assigned to a default button
in a dialog box

Move to the previous text box

Move to the next text box

Copy the object attributes

Paste the object attributes

Change the position of an object on a slide

Cycle forward or backward through the objects
until sizing handles appear on the object you
want to select

Remove font style (such as bold or superscript)
and effects. Does not affect font, size, or color.

Change the case of letters

Apply subscript formatting (automatic spacing)
Apply bold formatting

Centre a paragraph

Apply italic formatting

Justify a paragraph

Left align a paragraph

Right align a paragraph
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Formatting Characters and Paragraphs (continued)

0¥+

{0 3¥<
T8>
0 ¥C

1+ 38F; then use the « T — or | keys
to select the font

438V
£

£V

Moving around in Text

i

p
N

1

i
£
AN
B«
¥
£

Apply superscript formatting (automatic
spacing)

Decrease the font size
Increase the font size
Copy formats

Change the font

Paste formats

Change the formatting of characters (Font
command, Format menu)

Apply an underline

One line down

To the end of a line

To the beginning of a line

One character to the left

To the next title or body text placeholder
One character to the right

One line up

Down one paragraph

To the end of a text box

To the beginning of a text box
One word to the left

One word to the right

Up one paragraph
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Moving around in the Help Topic Pane

i

3#C

P«
¥
FW

Presentations
~H

~M

\)

4F10
X4F7

#D

¥*F
¥EK
#N
¥0
3L orF7
&P
#Q

Scroll toward the end of a Help topic one line at
a time

Scroll toward the end of a Help topic one
screen at a time

Scroll toward the beginning of a Help topic one
screen at a time

Scroll toward the beginning of a Help topic one
line at a time

Copy the selected items to the Clipboard
Go to the previous Help topic
Go to the next Help topic

Close the Help window

Replace text

Insert a new slide

Cancel an action

Display a contextual menu
Open the definition dictionary

Make a copy of the selected slide in outline
view, slide sorter view, or in the outline pane in
normal view.

Find text, formatting, and special items
Insert a hyperlink

Create a new presentation

Open a presentation

Check spelling

Print a presentation

Quit PowerPoint
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Presentations (continued)
38S
48D

3P
FW
*Y
¥*Z

Slide Shows
A or =

B or.

~H

~{B

~4S

E

O or &. or -
H

Hold down ~ and =¥
M

N or € or £ or = or | or ~ or the
space (or *¥)

)

Portor<—ortor&

Sor+

Save a presentation

Make a copy of the selected slide in notes page
view, or if the pointer is in slide pane or notes
pane in normal view.

Open the Project Gallery
Close a presentation
Redo or repeat an action

Undo an action

Show or hide the arrow pointer

Display a black screen, or return to the slide
show from a black screen

Hide the pointer and button immediately
Start slide show from the current slide
Start slide show from the first slide
Erase on-screen annotations

End a slide show

Go to next hidden slide if the next slide is
hidden

Display the contextual menu
Use mouse-click to advance while rehearsing

Perform the next animation or advance to the
next slide

Use original timings while rehearsing

Return to the previous animation or return to
the previous slide

Stop or restart an automatic slide show
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Slide Shows (continued)
T Set new timings while rehearsing

W or, Display a white screen, or return to the slide
show from a white screen

$A Redisplay hidden pointer and/or change the
pointer to an arrow

$P Redisplay hidden pointer and/or change the
pointer to a pen

U Hide the pointer and button in 10 seconds

Tables

s Insert a tab in a cell

1] Move to the next line or row

g Start a new paragraph

it Move to the preceding cell

- Move to the next cell

- at the end of the last row Add a new row at the bottom of the table

T Move to the preceding line or row

Text Boxes

+~ or — Move one character to the left or right

Selecting Text and Objects"

4l One line down

T+ One character to the left
- One character to the right
o1 One line up

-1 or {+—1 until the object you want is An object
selected
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Selecting Text and Objects (continued)

FBA
FBA
FBA
L
T¥®—

Windows

FW

Working in an Outline

X e

X{—

X{OT

AN

{1 on the numeric keypad
\_{*+ on the numeric keypad
\_{*- on the numeric keypad

{9 on the numeric keypad

All objects (slide view)

All slides (slide sorter view)
All text (outline view)

To the beginning of a word

To the end of a word

Close the active presentation window

Promote a paragraph

Demote a paragraph

Move selected paragraphs up
Move selected paragraphs down
Show heading level 1

Expand text below a heading
Collapse text below a heading

Show all text and headings
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More Shortcuts

Contact Us

You can send us an email at
contact form .

info@osxkeyboardshortcuts.com or use the website

Or visit the OS X Keyboard Shortcuts website ~ www.osxkeyboardshortcuts.com

Copyright © 2008 Dean Pirera Byron IT

www.osxkeyboardshortcuts.com

59


mailto:info@osxkeyboardshortcuts.com
mailto:info@osxkeyboardshortcuts.com
http://www.osxkeyboardshortcuts.com/contact-us.php
http://www.osxkeyboardshortcuts.com/contact-us.php
http://www.osxkeyboardshortcuts.com
http://www.osxkeyboardshortcuts.com
http://www.osxkeyboardshortcuts.com
http://www.osxkeyboardshortcuts.com

